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ВВЕДЕНИЕ 

 
 В настоящем пособии представлено исследование виртуальной 

модели двигателя внутреннего сгорания. Данный двигатель  представля-

ет собой двухтактный, одноцилиндровый ДВС воздушного охлаждения 

с зажиганием ТВС от калильной свечи, с резонансной настроенной вы-

хлопной трубой. Рабочий объем двигателя 2,47 куб.см., диаметр цилин-

дра 15 мм, ход поршня 14 мм, частота оборотов коленчатого вала 38000 

об/мин.  

 Цилиндропоршневая группа состоит из: бронзовой, покрытой 

внутри хромом гильзы, доведенной до определенного профиля, с пятью 

продувочными и одним выхлопным каналами (петлевая продувка 

Шнюрле); пустотелого поршневого пальца (Р6М5, HRC 63); шатуна со 

сквозным отверстием вдоль его тела, для обеспечения смазки пальца и 

втулками скольжения из антифрикционного материала; поршня из высо-

кокремнистого алюминиевого порошкового сплава САС 1-400 со сто-

порными кольцами, фиксирующими палец. Материалы гильзы и поршня 

обеспечивают достаточно стабильный зазор в этой паре в диапазоне ра-

бочих температур двигателя (150-250  °С). Коленвал консольного типа 

изготовлен из стали Р6М5 и HRC63-65, динамически уравновешен. До-

рожка качения коренного подшипника прошлифована на теле вала. 

 В работе предложена алгоритмизированная  методика формирова-

ния виртуальной конечно-элементной модели микролитражного двига-

теля внутреннего сгорания в программной среде Ansys Workbench.  

 

 

 

 



5 
 

1 Динамический расчет цилиндропоршневой группы 

Расчет цилиндропоршневой группы проводится в среде Ansys 

Workbench при помощи динамического анализа. Такой расчет требует 

значительные затраты ресурсов компьютера, однако является точнее 

статического расчета механизма, позволяя учитывать переходные про-

цессы и переменную нагрузку на поршень. 

 
1.1 Экспорт геометрической модели в Ansys Transient Structural 

 
Основные детали цилиндропоршневой группы представлены на 

рис. 1-6. 

 
Рисунок 1. Поршень 

 
Рисунок 2. Гильза 
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Рисунок 3. Втулка 

 
Рисунок 4. Палец 

 

 
Рисунок 5. Шатун 

 
Рисунок 6. Коленвал 

 
Шаг 1. Создайте сборочную модель цилиндропоршневой группы в 

любой системе 3D моделирования. На рис. представлена модель цилин-

дропоршневой группы, построенная в системе NX8. 
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Рисунок 7. Сборочная модель  

 
Сохраните сборку в формате Parasolid (рис. 8). Начальное положе-

ние цилиндра не имеет значения, оно будет настроено в Ansys Transient 

Structural. 
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Рисунок 8.   Экспорт 3D-модели цилиндропоршневой группы из NX 

 
2.2 Задание свойств материалов 

 
 

Шаг 1. Откройте Ansys Workbench. Добавьте в поле проекта мо-

дуль Transient Structural (рис. 9). 
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Рисунок 9. Окно проекта 

 
Шаг 2. Во вкладке Engineering Data введите свойства различных 

материалов, применяемых в данном механизме. В конструкции приме-

нены следующие материалы: Вал – сталь Р6М5Ф3, шатун – алюминие-

вый сплав АК4-1 T6, втулки – антифрикционная бронза ВБ-23-НЦ, пор-

шень – спрессованный порошковый алюминий САС-1-400, палец – сталь 

Р6М5Ф3, гильза – медный сплав БРБ-6.  

1) Щелкните ЛКМ на пустом поле в окне Сontents of Engineering 

Data, введите имя материала поршня SAS-1-400 (рис. 10). 

2) Слева в окне Toolbox представлены свойства, которые можно 

присвоить создаваемому материалу. Добавьте следующие свойства: 

плотность (Density), коэффициент линейного расширения (Isotropic Se-

cant Coefficient of Thermal Expansion), упругие свойства (Isotropic Elastic-

ity), пластичные свойства, задаваемые мультилинейной кривой пластич-

ности (Multilinear Kinematic Hardening). 
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Рисунок 10. Меню свойств материалов 

 
3) Задайте коэффициент температурного расширения в зависимости 

от температуры материала согласно рис. 11. 

 
Рисунок 11 Коэффициент линейного расширения материала САС-1-400 

 
4) Задайте модуль упругости и коэффициент Пуансона согласно 

рис. 12 

 
Рисунок 12. Модуль упругости материала САС-1-400 



11 
 

5) Задайте кривые пластичности для трех значений температуры 

материала согласно рис. 13 – 15. 

 
Рисунок 13.  Пластические свойства САС-1-400 при температуре 200С 

 

 
Рисунок 14. Пластические свойства САС-1-400 при температуре 100 0С 

 

 
Рисунок 15.  Пластические свойства САС-1-400 при температуре 300 0С 
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На рис. 16 приведены кривые пластичности материала САС-1-400 

[1]. 

 
Рисунок 16. Мультилинейные кривые пластичности 

 
6) Аналогично добавьте материал АК4-1 Т6. Введите следующие 

свойства материала: плотность 2800 кг/м3;  модуль упругости 7,1·1010 

Н/м2; коэффициент Пуансона 0,3  

7) Добавьте материал БРБ-2 со следующими свойствами: плотность 

8250 кг/м3 модуль упругости 1,2·1011 Н/м2, коэффициент Пуансона 0,3. 

Коэффициент термического расширения согласно рис. 17. 

 
Рисунок 17. Коэффициент термического расширения материала БРБ-2 

 
8) Добавьте материал ВБ-23-НЦ  со следующими свойствами: плот-

ность 9150 кг/м3 модуль упругости 7,35·1010 Н/м2, коэффициент Пуансо-

на 0,35. 

9) В качестве материала вала и пальца оставьте сталь по умолчанию 

(structural steel). 
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Шаг 3. Запустите модуль , в появившемся окне 

установите единицы измерения миллиметры (рис. 18). 

 
Рисунок 18. Установка единиц измерения 

 
Шаг 4. Импортируйте геометрию цилиндропоршневой группы: File 

→ Import External Geometry File (рис. 19). 

 

Рисунок 19. Импорт геометрии 

 
 После импорта модели нажмите кнопку .  Результат пред-

ставлен на рис. 20. 
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Рисунок 20. Модель механизма в Ansys Design Modeler 

 
2.3 Создание кинематических пар 

 
Шаг 1. Откройте модуль . Переименуйте детали 

сборки как показано на рис. 21. Изначально все детали имею название 

Solid, что является неудобным при назначении соединений в сборке. 

 
Рисунок 21. Обозначение элементов механизма 

 
Также во вкладке Material присвойте элементам сборки соответст-

вующие материалы. 
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Шаг 2. Программа автоматически создает контактные пары, тип 

пары по умолчанию – Bonded (жестка сцепка). В данном примере кон-

тактные пары будут заменяться соединениями механизма (joint), поэто-

му удалите все контактные соединения, щелкните ПКМ по в 

дереве модели и нажмите delete в выпадающем меню. 

Шаг 3. Установите тип тел Rigid во вкладке  дерева про-

екта (рис. 22). Таким образом, на первом этапе модель будет рассчитана 

как механизм, без расчета напряженного состояния составных элементов 

цилиндропоршневой группы. При этом визуально конечно-элементная 

сетка после её создания отображаться не будет. При необходимости оп-

ределения НДС отдельных элементов, надо поменять тип тела с Rigid на 

Flexible и еще раз сгенерировать сетку. При этом время расчета значи-

тельно возрастает, поэтому для учебных целей целесообразно рассчиты-

вать НДС деталей по отдельности, но в составе механизма. 

 

 
Рисунок 22. Настройка свойств элементов сборки 

 
Шаг 4. Введите соединения механизма. Щелкните ПКМ по 

, далее Insert → Joint (рис. 23). 
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Рисунок 23. Введение соединений в модель 

 
В появившемся меню (рис. 24.) необходимо выбрать соединяемые 

поверхности, а также тип соединения (сцепка, относительно вращение, 

перемещение вдоль оси детали). При вводе соединений целесообразно 

скрыть (Hide body) отдельные элементы сборки, оставив на экране толь-

ко соединяемые (рис. 25). 

 
Рисунок 24. Меню выбора соединяемых поверхностей 
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Рисунок 25. Операция Hide Body 

 
При выборе соединяемых поверхностей их можно перебирать в ле-

вом нижнем углу экрана (рис. 26), после выбора поверхности прокон-

тролируйте название тел в графе Body вкладок Reference и Mobile. На 

рис. 26 приведен пример создания вращающейся кинематической пары  

втулки шатуна и коленвала. 

 
Рисунок 26. Введение соединения втулки шатуна и коленвала 
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Шаг 5. Введите соединение поршня и гильзы, разрешив перемеще-

ние поршня внутри гильзы (Cylindrical). 

 
Рисунок 27. Соединение гильзы и поршня 

 
Шаг 6. Соедините «верхнюю» втулку шатуна и шатун, тип соеди-

нения Fixed. 

Шаг 7. Задайте соединение пальца и «верхней» втулки шатуна, тип 

соединения Revolute. 

Шаг 8. Соедините «нижнюю» втулку шатуна и шатун, тип соеди-

нения Fixed. 

Шаг 9. Зафиксируйте гильзу в пространстве, выберите на панели 

инструментов вкладку Body-Ground (рис. 28), далее Fixed укажите по-

верхность гильзы согласно рис. 29. 
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Рисунок 28 Меню закрепления модели 

 

 
Рисунок 29. Закрепляемая поверхность гильзы 

 
Шаг 10. Аналогично создайте граничное условие для вала, указав 

Revolute в выпадающем меню (рис. 30). В качестве закрепляемых по-

верхностей укажите зоны установки подшипников (рис. 31). 
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Рисунок 30. Меню закрепления модели 

 

 
Рисунок 31. Зоны установки подшипников 

 
Кинематические пары в модели показаны на рис. 32. 

 
Рисунок 32. Кинематические пары 
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Шаг 11. Задайте начальное расположение механизма. Для этого 

сначала щелкните ЛКМ на соединении Cylindrical – gilza To porshen , за-

тем на панели инструментов выберите . Перемещая поршень 

вдоль гильзы (рис. 33), установите его в нижнюю мертвую точку. 

 
Рисунок 33. Установка начального расположения механизма 

 
Шаг 12. Сгенерируйте сетку конечных элементов: Mesh → Generate 

(у тел типа Rigid конечные элементы не отображаются). 
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2.4 Приложение граничных условий и расчет работы механизма 
 
 

Шаг 1. Настройте параметры расчета. Щелкните ЛКМ по 

. Во вкладке Number Of Steps задается количество шагов 

динамического расчета. Общее время расчета 0,0015 с (время одного 

оборота коленвала). Задайте общее количество шагов расчета 18. Меняя 

значение во вкладке Current Step Number задайте количество подшагов 

на каждом шаге расчте (Substeps) как показано на рис. 34. В графе Step 

End Time задается время, соответствующее каждому шагу расчета. В 

данном примере в каждый шаг расчета составляет 0,00083 с (1/18 от об-

щего времени расчета). 

 
Рисунок 34. Параметры решателя 

 
Шаг 2. Задайте угловую скорость вращения. Для этого щелкните 

ПКМ по Transient  в дереве модели и в выпадающем меню выберите 

Joint Load (рис. 34). 
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Рисунок 34. Задание инерционной нагрузки на механизм 

 
Угловая скорость вращения коленвала 40000 об/мин, или 4188,8 

рад/с. Для начального момент времени задайте нулевую угловую ско-

рость, для всех остальных задайте 4188,8 рад/с. 

Шаг 3. Запустите модель на расчет. Контролировать ход расчета и 

сходимость можно во вкладке  в меню   (рис. 

35). 

 
Рисунок 35. Данные о расчете 

 
Шаг 4. Выведите на экран данные о деформации модели (рис. 36) 
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Рисунок 36. Вывод информации о деформации модели 

 
По завершении расчета выведите на экран анимацию вращения мо-

дели (рис. 37). 

 
Рисунок 37 Настройка анимации вращения модели 
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2.5 Расчет напряженно-деформированного состояния поршня 

 
Шаг 1. Установите тип твердого тела поршня Flexible (рис. 38) 

 

 
Рисунок 38. Тип тела поршня 

 
Шаг 2. Создайте дополнительную систему координат для ввода из-

менения температуры по телу поршня. Щелкните ПКМ по 

в дереве проекта, введите декартову систему координат, 

в качестве привязки выберите поверхность поршня, показанную на рис. 

39. 

 
Рисунок 39. Привязка вспомогательной системы координат к поршню 

 
Шаг 3. Задайте максимальный размер конечного элемента 1 мм. 

Для этого щелкните ПКМ по вкладке Mesh → Insert → Sizing (рис. 40). 
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Рисунок 40. Вызов меню установки размера конечного элемента 

 

 
Рисунок 41. Установка размера конечного элемента 

 
Шаг 4. Установите тип создаваемой сетки. Можно выбрать тетра-

эдальную сетку (Path Conforming) либо с преобладанием гексаэдров 

(Hex Dominant). Выберите тип гексаэдральную сетку (рис. 42). 
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Рисунок 42. Установка типа сетки конечных элементов на поршне 

 
Шаг 5. Сгенерируйте сетку конечных элементов. Результат пред-

ставлен на рис. 43. 

 
Рисунок 43. Конечно-элементная модель поршня 

Распределение давлений по расчетной модели было получено в 

нестационарном газодинамическом расчете проточной части двигателя 
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малой мощности [1]. Пример поля распределения полного давления 

представлен на рис. 44. 

 
Рисунок 44. Поле распределения давлений 

 
Для определения давления на днище поршня было выполнено со-

хранение значений полного давления каждые два градуса поворота ко-

ленчатого вала. Зависимость давления на днище поршня от угла поворо-

та коленчатого вала представлена на рис. 45. 

 
Рисунок 45.  Зависимость давления на днище поршня от угла поворота ко-

ленчатого вала. 
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Так же было получено распределение температуры по высоте 
поршня (рис. 46).  

 
Рисунок 46. Зависимость температуры поршня от его высоты 

 

Шаг 6. Приложите температурную нагрузку к поршню. Щелкните 

ПКМ по вкладке Transient в дереве модели, в выпадающем меню выбе-

рите Thermal Condition (рис. 47). 

 

 
Рисунок 47. Температурная нагрузка 

 
Выберите тело поршня, в графе Magnitude установите ввод темпе-

ратуры при помощи таблицы (Tabular data), в графе Independent Variable 

установите зависимость от координаты Z (по умолчанию стоит зависи-
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мость от времени), в качестве системы координат установите созданную 

вспомогательную систему координат (рис. 48). 

 
Рисунок 48. Меню создания температурной нагрузки 

 
Распределение температуры по высоте поршня представлено на 

рис. 49 -50. 

 
Рисунок 49 Зависимость температуры от высоты поршня 

 

 
Рисунок 50. Визуализация распределения температуры по поршню 
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Шаг 7. Приложите давление к поршню. Щелкните ПКМ по Tran-

sient → Insert → Pressure. Укажите поверхность поршня, показанную на 

рис. 51. 

 
Рисунок 51. Ввод давления  

 
Рисунок 52. Поверхность поршня, к которой прикладывается давление 
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Зависимость распределения давления показана на рис. 53.  

 
Рисунок 53. Зависимости давления на поршень от времени 

 
Шаг 8. Запустите модель на расчет. Процесс сходимости расчета 

можно посмотреть во вкладке Solution information (рис. 54) 

 
Рисунок 54. Процесс сходимости расчета 

 
Шаг 9. Отобразите результаты расчета. Выведите эквивалентные 

напряжения в поршне.  Щёлкните  ПКМ на вкладке Solution → Insert → 

Stress → Equivalent (von-Mises) 
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Рисунок 55. Вывод эквивалентных напряжений 

 
Щелкните ПКМ по Equivalent Stress в дереве проекта, в выпадаю-

щем меню выберите Evaluate All Results (рис. 56) 

 
Рисунок 56. Расчет эквивалентных напряжений в поршне  

 
Шаг 10. Создайте сечение поршня для визуализации напряжений 

внутри детали, для этого в графе Section Planes установите отметку в 

окошке Section plane 1,проведите вертикальную линию, разделяющую 

поршень на две половины 
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Рисунок 57. Создание сечения поршня 

 
На рис. 58 представлено распределение эквивалентных напряжений  

 
Рисунок 58. Эквивалентные напряжения в поршне 
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Максимальные эквивалентные напряжения в поршне составили 110 
МПа, что значительно меньше допускаемых 

Шаг 11. Выведите пластические деформации, возникающие в 

поршне (рис. 59 - 60). 

 
Рисунок 59. Вывод эквивалентных пластических деформаций 

 

 
Рисунок 60. Пластические деформации в поршне 
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2.6 Расчет напряженно-деформированного состояния шатуна 
 

Шаг 1. Аналогично поршню механизма, задайте для шатуна тип 
твердого тела Flexible (рис. 61 ) 

 
Рисунок 61. Установка типа тела для шатуна 

 
Шаг 2. Задайте максимальный размер конечного элемента для ша-

туна 1 мм (рис. 62). 

 
Рисунок 62. Установка размера конечного элемента для шатуна 

 
Шаг 3. Установите тетраэдальный  тип создаваемой сетки конеч-

ных элементов. Сгенерируйте сетку (рис. 63) и запустите модель на рас-

чет 
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Рисунок 63. Конечно-элементная модель шатуна совместно с поршнем 

 
Шаг 4. Выведите на экран эквивалентные напряжения в шатуне 

(рис. 64) 

 
Рисунок64. Изменение эквивалентных напряжений в шатуне 
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Максимальные эквивалентные напряжения составили 133 МПа, что 

значительно меньше допускаемых. 

 
2.7 Расчет напряженно-деформированного состояния коленчатого 

вала 
 

Шаг 1. Установите тип сетки для вала Hex Dominant. 

Шаг 2. Задайте максимальный размер конечного элемента 1 мм. 

Шаг 3. Сгенерируйте сетку конечных элементов. 

 
Рисунок 65. Конечно-элементная сетка коленчатого вала 
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Рисунок 66. Эквивалентные напряжения в коленчатом валу 

 
Максимальные напряжения достигают 1750 МПа. Допускаемые на-

пряжения для быстрорежущей инструментальной стали Р6М5Ф3 состав-

ляют 2900 МПа, следовательно вал удовлетворяет условиям прочности. 

 

ЗАКЛЮЧЕНИЕ 

 

Рассмотрены аспекты формирования виртуальной конечно-

элементной модели цилиндропоршневой группы двигателя внутреннего 

сгорания в ANSYS Workbench. Подробно изложены вопросы создания 

прочностной и динамической моделей. Даны практические рекоменда-

ция по использованию предложенной технологии решения подобных 

сопряжённых  задач на примере микролитражного двигателя. 
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